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Welcome to DataFlex Reports 2019 Developer Edition – 7.0.1  
 
 
Important information for existing DataFlex Reports users: 
 
The {&Page Number}, {&Total Page Count} and {&Page N of M} special Fields behave 
differently when used in functions. 
Prior to version 7 these special fields - when used in functions - would not take the ‘Reset page number 
after this section’ option into account. Starting with version 7 RC special fields will always have the same 
value regardless if they’re used in functions or not. 
 
Use of Global variables when calling functions. 

Version 7 of DataFlex Reports no longer resets global variables after calling a function. For example in 
versions prior to 7.0 the gTotal variable would always be 10 in the following function even when the 
function ‘IncrementTotal’ would change the gTotal value. 
 
dim gTotal as global 

dim lResult 

 

let gTotal = 10 

let lResult = {@IncrementTotal} 

return gTotal 

 
Font sizes are calculated differently in version 6.0 and up of DataFlex Reports. This can have 
an effect on the layout of existing 5.0 reports. 
DataFlex Reports version 6 calculates font sizes differently compared to previous versions. This means 
the overall size of text may differ and can cause clipping of fields which did not occur in previous 
versions. Also, when using small fonts (less than 10 pts) the text may appear more greyish compared to 
previous versions.  
 
String comparison in expression evaluator. 
String comparison in previous versions of DataFlex Reports (up to and including DataFlex Reports 6.0 

Beta I) were case-insensitive. Starting with version 6 Beta II, a new option ‘Use case-sensitive 
comparison in functions’ has been added to address what should be considered a bug. For example the 
following function would return “case insensitive”. 
 
if ("A" = "a") then 
     return "case insensitive" 
end 
 
The option ‘Use case-sensitive comparison in functions’ is turned on by default for new reports. Existing 
reports have this option turned off to ensure backward compatibility. We strongly recommend you keep 
this option turned on for all new reports and advise you check your existing reports and turn this option 
on if your report(s) do no rely on case-insensitive string comparison. 

 
Please note only string comparison operators <, <=, =, >=, > and <> are affected by this option. 
 
  



Existing reports  
The .dr (or .vrw for older reports) report definition format has changed for version 7.0. If you save 
reports with this version of DataFlex Reports, you can no longer use them in previous versions. 
 
Special caution with regards to this: when opening reports that were created with an older version it is 
advised to run the ‘check database’ option. 

 
Integration library 
Please update the integration library in your workspace(s) and recompile your application(s). After 
attaching the 7.0.1 library to your workspace(s) you should run the ‘Scan for images’ option in the 
DataFlex Studio project properties dialog to replace the BMP files in you project’s .cfg file with the new 
ICOns. 
 
To ensure the DataFlex Studio will correctly handle labels for GUI controls and avoid warnings in the 
problem resolution panel of the DataFlex Studio you should add the IS$WEBAPP to the Tools | Configure 
Workspace | Conditionals | Workspace #IFDEF conditionals for your DataFlex Studio version 18.1 - 19.1 
Windows GUI applications. 
 

A DataFlex 18.1 through 19.1 Studio license is required to use the Integration library which is part of 
DataFlex Reports 2019 Developer Edition. 
 
Installation  
DataFlex Reports 2019 – 7.0.1 is developed with DataFlex 19.0. If you do not have a version 19.0 Client 
License running on your PC, the setup will automatically install one for you. 
 
DataFlex Reports 2019 – 7.0.1 can run side-by-side with previous versions of DataFlex Reports. 
  
Supported platforms 

- Microsoft Windows 10 
- Microsoft Windows Server 2019 (including x64) 

- Microsoft Windows Server 2016 (including x64) 
- Windows Terminal Services when using Windows Server 2019 or Windows Server 2016 
- Citrix Virtual Apps and Desktops (formerly XenApp) when used in conjunction with other 

supported Windows operating systems 
 
Registration  
DataFlex Reports 7.0.1 will run as a 60-day trial version. If you start DataFlex Reports you will be asked 
to register your version. To register, you need to purchase a license. Registering will lift the trial period. 
After registering your license you have a 60 day period to activate your license. Make sure you have an 
internet connection, and simply confirm the activation. 
Click here to learn where you can order your license.  

  
 
 
  

https://www.dataaccess.com/about/regional-offices-382


What is New in version 7.0?  

 

Edit in preview 

Starting with DataFlex Reports 7.0 you can change the report layout when previewing the report. No 

more need to go back and forth between the design and preview when making layout changes, simply 

change the layout from the preview tab and the changes can be viewed immediately. This can be a great 

time saver especially when fine-tuning the report design. 

 

Locale per report 

In DataFlex Reports 7.0 you can set a locale per report, allowing you to create reports intended for 

different locales without having to change your windows settings. This also allows you to deploy reports 

for different locales on a single (web) server.  

 

  



What is New in version 6.2?  

 

Crosstab support 

DataFlex Reports 6.2 introduces a crosstab field type (also known as a pivot-table) which allows you to 

display your data in a table. All summaries are automatically calculated or you can use a custom 

function for your summaries. In addition you have full control over how the lines, margins etc. in the 

crosstab are displayed. In order for crosstabs to work properly you should set the ‘Section can span 

multiple pages’ option for the sections in which crosstabs are placed. The crosstab wizard can 

automatically set this option for you. 

 

 

Side-by-Side assembly 

The DataFlex Reports Studio is now able to run as a side-by-side assembly. This means it no longer 

relies on any registered components to operate (also known as ‘regfree’) eliminating the risk of conflicts 

or missing shared components – such as CodeJock. 

 

DPI scaling support 

Support for dot per inch (DPI) scaling has been added to all toolbars, menus and context menus. In 

addition newly designed icons – ranging from small to large – have been added to the DataFlex Reports 

Studio and Integration Library. 

 

New formatting and conversion functions 

A number of new build-in formatting function have been added. These functions allow you to convert 

data – such as date, time, number, currency and integer - using a mask or the Windows default setting. 

A number of conversion functions have been added which allow you to specify sizes and positions - in 

inches, centimeters or points – independent of the Windows locale settings of the machine on which the 

report runs. 



DSN-less connection string builder 

A connection string builder option has been added to the ODBC connection wizard for DSN-less 

connections. Depending on the driver you select you will be prompted for all the required information to 

create the connection. You can easily modify the connection string at runtime use the integration library 

included with the Developer Edition of DataFlex Reports. 

 

 

 

Improved Excel Export 

A new option ‘Export data using native Excel datatypes’ has been added to the Excel export. When using 

this option all data types are converted to – unformatted - native Excel data types. This makes it easier 

to make changes to the exported data in Excel. 

 

Datasource connection errors option 

A new option ‘Show datasource connection errors’ is now available. With this option all errors which 

occur when you connect to a datasource are reported which can help you determine why you cannot 

connect to a particular datasource. 

  



Import/Export of RDS data 

RDS (Runtime DataSource) table structures and sample data can now be exported and imported. This 

means you no longer need to re-enter the RDS table structure for each report in which you want to use 

the table or re-enter the RDS sample data after you have made changes to the RDS table structure. The 

RDS data is stored as JSON in a separate file which you can easily copy between workstations. 

 

  

 

Bigint support 

Support for 64 bit integers has been added to all the Database drivers supplied with DataFlex Reports. If 

you use any 64 bit integers in your database(s) simply run ‘Check Database’ from the DataFlex Reports 

Studio or use the Maintenance utility to start utilizing this new data type. 

 

Improved Barcode support 

Barcode support has been improved with a new option to set the default barcode type and an option to 

display the humanly readable text which appear underneath some barcode types. Furthermore you can 

now change a parameter field to a barcode. 

 

 

  



SQLite driver 

SQLite is a widely used zero-configuration SQL database. It is used by DataFlex Reports for its internal 

data storage. The new SQLite driver included in DataFlex Reports is a native driver and does not rely on 

an installed ODBC driver or any other dependencies. Just like the ODBC driver the SQLite driver allows 

you to base your reports on a SQL statement and supports the SQL() function. 

 

 

 

  



What is New in version 6.0?  

 
Barcode support 
 
DataFlex Reports 6.0 supports over 70 different types of symbologies (type of barcodes) both one-
dimensional and two-dimensional (stacked) symbols are available. Fields (like database fields, functions 
or parameter fields and text objects) can be converted to a barcode with a simple mouse click and can 
be exported to PDF, RTF, HTML or image.  
 

 
 

 
Performance improvements 

Version 6 of DataFlex Reports contains many performance improvements to optimize the report 
generation process. A function pre-compiler has been added which makes reports with lots of functions 
run up to 10(!) times faster; the performance of summaries (both summary fields and the Sum() 
function) has also dramatically improved. Additional changes have been made to the layout engine to 
streamline the report generation. 
 
  



Functions and function editor 

A new case statement has been added to version 6 of DataFlex Reports. The case statement supports 
comma separated lists of values and does not allow fall-through to occur. Case statements can be 
nested. In addition to the case statement, whenever a function error occurs, the function editor is 
opened and the symbol which caused the error is highlighted. Selected text can now be commented and 
uncommented using the Ctrl+K,C and Ctrl+K,U keys or toolbar buttons. Additionally line comments can 
be toggled using the Ctrl+/ key. 
 

 
 
 



Embedded SQL 

A new built-in function SQL() has been added to DataFlex Reports 6.0 which allows you to execute SQL 
statements directly (also known as SQL expressions). This function is only available for ODBC data-
sources and is a powerful addition to report developers. However, only a single value can be returned 
from a SQL() function.  
 

 
 

 
  
 

 
  



Changes between 7.0 and 7.0.1 
- Fixed sporadic crash when designing reports  

 
Changes between 7.0 RC and 7.0 
Bug fixes/improvements: 

- HDE 6051 Fixed invalid message error when creating a page layer while previewing a report 

- HDE 6046 Undo in previewer does not always undo the changes 
- HDE 6050 When dragging an object in the previewer the cursor position does not always match 

the object being dragged 
- HDE 6051 Fixed crash when previewing reports 

 
Changes between 7.0 Beta II and 7.0 RC 
Bug fixes/improvements: 

- HDE 5078 A repeated group header shows incorrect record 
- HDE 5986 Report footer section with option ‘Section can span multiple pages’ can print over the 

bottom margin 
- HDE 5954 Focus does not always move to previewer when clicked 
- HDE 5430 Removing a Stored Procedure table from a report does not remove the associated 

parameters 
- HDE 5995 ‘Open file after export’ option does not work after multi-page HTML export 
- HDE 5138 Page header can display weird values on the last page 
- HDE 5030 ‘Page Number’, ‘Total Page Count’ and ‘Page N of M’ special fields return different 

values when the options ‘Reset page number after this section’ is set and used from a function 
- HDE 5974 Browse data on a Stored Procedure table now returns empty list instead of an error 

message 
- HDE 5929/5951 Error 4509 when running report with a subreport 
- HDE 5959 Accelerator keys do not work for checkbox and combobox controls 
- HDE 5969 ‘Count’ and ‘Distinct Count’ summary types are formatted as numbers instead of 

integers 
- HDE 5973 Current connection in Database Expert for SP based reports shows strange tables 

- HDE 6021 Cannot select table link in Database Expert after deleting a table 
- HDE 5963 Edit text in previewer does not show edit window 
- HDE 6024 Accelerator keys for recent files in the File menu do not work 
- HDE 6030 GDI resource leak 
- Edit in preview 

o Fixed ‘Array out of bounds’ errors 
o ‘Esc’, ‘Ctrl+Up and ‘Ctrl+Down’ keys in previewer do not work as expected 
o Position of objects in design tab are not always in sync with preview tab 
o Undo in previewer does not always undo the changes made 
o Fixed moving a field within the same section with the mouse in the previewer 

Library: 

- The dialog used when a function in a report contains an error does not show the report name in 
a web application 

- The ExportReport.wo and ExportReportDialog.wo web components now have a checkbox for 
Excel native formatting for XLS export 

 
Changes between 7.0 Beta and 7.0 Beta II 
Bug fixes/improvements: 

- HDE 5834 Last field in SQL statement is not displaying 
- HDE 5836 Problem with filters using a SQL based report 
- HDE 5876 Options ‘Repeat Group Header’ and ‘Print next section on same page’ are ignored 
- HDE 5917 Problem when deleting a Group name object used in a chart 
- HDE 5894/5901 DR 6.2 shows the DR 7.0 help when help is copied to DF folder from installation 

(fixed starting 7.0, no fixed 6.2 version available) 
- HDE 5944 Problem with filters on dates with descending index using embedded (DataFlex) 

database 
- HDE 5945 Object positioning using a function does not work in combination with variable height 

option 
- Edit in preview 

o Cannot select fields when report contains a page layer 
o Cannot select fields when behind a box object 
o Progress popup no longer shows when editing in preview 
o Performance improvements 
o GPF when moving fields to different sections 

 
Changes between 6.2 and 7.0 Beta 
New features: 



- Edit in preview 
- Locale per report 

Bug fixes/improvements: 
- HDE 5716 Function Explorer does not save changes when switching between functions 
- HDE 5793 Dragging a .dr file with accentuated characters (for example umlaut) onto DR studio 

does not open the report 

- HDE 5787/5768 Setting the option Variable Height in a sub-section (i.e. Details B) can cause a 
GPF error 

- HDE 5735 Translation error in crosstab wizard 
- HDE 5718 Median calculation is incorrect 
- HDE 5364 Add “Administrator” to DR caption bar when running in administrator mode 
- HDE 3630 Show field numbers in the Field Explorer 
- HDE 5198 a SQL() function without a connection in the report should give an error message 
- HDE 5372 Add an option to center a field on the page 
- HDE 5758 Move objects using Ctrl+Shift+Cursor keys in large increments 
- HDE 5335 Allow drDistinctCount to work with all data-types 
- HDE 5697/5849 Starting with version 6.2 filters on the Date datatype do not work with the 

DataFlex (embedded) database anymore 

- HDE 5720 Crosstab totals are sometimes incorrect 
- HDE 5138 When exporting to RTF a black bar and extra space can occur 
- HDE 5681 Error message when using version 6.2 Maintenance utility 
- HDE 5743/5804 Starting with version 6.2 a Number type in the DataFlex (embedded) database 

without decimals is converted to an integer and can cause conversion errors 
- HDE 5811 Find by Function ID option does not find the function 
- HDE 5306 Incorrect Font size when exporting to PDF in high quality mode 

 
Changes between 6.2 Beta I and 6.2 RC I 
Changes: 

- Median support 
- New reset page number logic 

- Improved HTML export 
- CLOB and DBCLOB support for DB/2 

Bug fixes: 
- https://support.dataaccess.com/Forums/showthread.php?62771-DR6-1-5-Using-a-complex-

SQL-Statement 
- HDE 5433 Cannot create a report based on a Stored Procedure 
- HDE 5451 Paste in a textbox pastes text AND any object on the clipboard 
- HDE 5430 Parameters not removed after removing a Stored Procedure from a report 
- HDE 5437 Month name in English, long date in German 
- HDE 5506 Check database on a SQL based report does not detect changes (only when run a 

second time) 

- Fixed crash when a function in a CrossTab generates an error 
- Fixed problem when deleting a function which is used in a Chart 
- Fixed problem with copying between reports when copied from report is closed before pasting 
- HDE 5641 Problem with 'Total page count' and 'Page N of M' special fields when used with case 

statement 
 
Changes between 6.2 Beta I and 6.2 Beta II 
Bug fixes: 

- Fixed incorrect internal version id in the Maintenance utility 
- Fixed problem with dates in DataFlex driver 
- Fixed problems with missing DataFlex runtime files in the installation 
- HDE 5471/5406 https://support.dataaccess.com/Forums/showthread.php?62658-DR-6-2-Test-

Findings fixed ‘Dialog failed’ error when creating a new report based on a SQL statement 
- HDE 5468 https://support.dataaccess.com/Forums/showthread.php?62658-DR-6-2-Test-

Findings Fixed ‘index out of bounds’ error when creating report based on SQL statement via 
Database Expert 

- HDE 5470 https://support.dataaccess.com/Forums/showthread.php?62658-DR-6-2-Test-
Findings Current connection in Database Expert does not show SQL statement 

- HDE 5469 https://support.dataaccess.com/Forums/showthread.php?62658-DR-6-2-Test-
Findings Fixed ‘Table mismatches’ error when using Check database on a SQL statement report 
and changing the statement 

- HDE 5427 Fixed problem with umlaute character (accentuated characters) 
- HDE 5429 Cannot create SQL based report from Database Expert 

- HDE 5475 Wrong icon in toolbar 
- HDE 5449 ODBC connection wizard creates incorrect SERVER when using managed connections 

with MS-SQL 
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- HDE 5434 Create DSN less connection does not allow you to specify a server not listed in the 
combo 

- HDE 5431 Managed connection list is not automatically populated and does not include 
connection information 

- HDE 5466 Incorrect data when using SQLite SQL statement 
- HDE 5461 Browse data does not work on SQLite database 

- HDE 5462 Weird characters when using SQLite database with accentuated characters 
- HDE 5291 Paint problem in Designer (design tab) when scrolling a label report horizontally 

Library: 
- Added DataFlex 19.1 library  
- DF_Material support (new default theme for 19.1) 

 
Changes between 6.1.5 and 6.2 
New features: 

- Added Crosstabs (pivot-tables) 
- Ability to copy DataFlex Reports Studio options from the install program 
- Added SQLite driver 
- Added Connection string to ODBC connection wizard 

- Option to show errors when connecting to a Data source 
- Added formatting functions: FormatDate(), FormatTime(), FormatNumber(), FormatCurrency() 

and FormatInteger() 
- Bigint support 
- HDE 3312 Option for exporting to Excel in native datatype 
- Side-by-side support for the DataFlex Reports Studio 
- DataFlex Reports Studio is now DPI aware and has new icons 
- HDE 4104 Added Import and Export of RDS tables and sample data to RDS 
- Added ability to hide/show row number in RDS sample data dialog 
- Hide barcode text and default barcode type 

https://support.dataaccess.com/Forums/showthread.php?60737-DR6-0-Beta-2-
Barcodes&highlight=barcode 

- https://support.dataaccess.com/Forums/showthread.php?62374-DR6-1-5-Barcode-option-not-
available-for-parameters 

- https://support.dataaccess.com/Forums/showthread.php?62353-YAFR-ConnectionID-in-the-
New-Report-Wizard&highlight=connection 

- Added functions for the position and size of objects 
https://support.dataaccess.com/Forums/showthread.php?55293-Two-more-
suggestions&highlight=position 

- Added UnitInch(), UnitCm() and UnitPt() functions 
 
 

Bug fixes: 

- HDE 5135 https://support.dataaccess.com/Forums/showthread.php?61986-DR-6-1-4-Setup 
- HDE 5019 Fixed broken link in the Control Panel’s ‘Programs and Features’ for DataFlex Reports 
- HDE 5040 ‘Size To Font’ option no longer allowed on barcode 
- HDE 5273 Fixed keys (line Tab and Enter) not working in search dialog 
- HDE 5146 Installer no longer removes DR registration files during uninstall 
- HDE 5224 Problem with position of Group Header in a subreport 
- https://support.dataaccess.com/Forums/showthread.php?62252-DR-craches-with-long-text-in-

memo-field 
- HDE 5092 Exporting a report with Page Layers to Excel will result in blank lines 
- HDE 4523 https://support.dataaccess.com/Forums/showthread.php?59482-DR5-01-Export-to-

XLS-does-not-start-at-Row-1 
- HDE 5266/5253 Fixed ‘Unable to read report (possibly damaged)’ error when report contains 

empty functions 
- HDE 5022 Fixed problem with empty (NULL) Memo and Binary columns displaying random 

characters 
- https://support.dataaccess.com/Forums/showthread.php?62288-Error-4509 

https://support.dataaccess.com/Forums/showthread.php?62272-Output-to-
PDF&highlight=PDF+opened 

- HDE 5030 https://support.dataaccess.com/Forums/showthread.php?62391-New-page-number-
on-change-of-group-no-longer-working-(DR-6-1-5-9607) 

- HDE 5315 Find dialog does not get the focus 
- https://support.dataaccess.com/Forums/showthread.php?62439-DR-6-1-5-Issue-with-Text-

Objects&highlight=cut+paste 

 
 

Library: 
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- HDE 5272 OnPreviewClick no longer redirects errors to cDRReport object 
- HDE 5178 Fixed bug in export file name 
- HDE 5293 https://support.dataaccess.com/Forums/showthread.php?62275-Function-

TableNumber-is-not-resetting-local-error-handling 
- HDE 5281 Error message after pressing Help (F1) in Integration Wizard 
- Library is now DPI aware and has new icons 

 
 
 
 
Language support  
DataFlex Reports ships with support for a number of languages. Before changing the language used in 
DataFlex Reports you must set your Windows Regional Options to the language of your choice. This 
ensures that the correct (ANSI) code page is selected in Windows. You can change the Regional Options 
in the Windows Control Panel, for full language support you must change both the ‘Standards and 
formats’ option to ensure correct date and number handling and the ‘Language for non-unicode 
programs’ option. Please note that the name of these options may differ in various versions of Windows. 
After changing the Windows Regional Options you can change the language in DataFlex Reports by 

choosing a language from the ‘Language’ menu.  
 
Integration library  
DataFlex Reports comes with an Integration library. This library allows you to seamlessly integrate 
reports with your DataFlex 18.1 through 19.1 applications. The library contains an Integration Wizard 
and classes for integrating and viewing reports. During installation you can specify the location of the 
Integration library. We suggest you install the library in a subfolder of the main DataFlex directory, this 
allows you to add the library using relative paths. To use the Integration library and Integration Wizard 
in your DataFlex projects and Workspaces you must first add the library. You can do this by opening the 
DataFlex Studio and select the ‘Maintain Libraries…’ option from the ‘Tools’ menu. Next, you can use the 
‘Add Library’ button and open the ‘DataFlex Reports XXX.sws’ file. After selecting the .sws file and 
clicking the ‘Ok’ button a wizard will be started which will guide you through the process of adding the 

library to the currently selected workspace.  
For windows application, simply choose the ‘View/Report’ option from the ‘File’ menu and select the 
‘DataFlex Reports Wizard’ icon. For Web applications use the ‘Web Object’ option from the ‘File’ menu.  
 

Reporting bugs, comments and suggestions  

Please report bugs to Data Access via our HelpDesk Express application (https://hde.dataaccess.eu). 

Please create a new account if you do not have one currently. Make sure to provide as much detail as 

possible to define and reproduce the problem that you are reporting. Upon your report, you will be 

invited to use an account on our help-desk support system for reporting future issues. For further 

communications and information, there is a forum devoted to DataFlex Reports in the Data Access 

Worldwide Support Forums. 

https://support.dataaccess.com/Forums/showthread.php?62275-Function-TableNumber-is-not-resetting-local-error-handling
https://support.dataaccess.com/Forums/showthread.php?62275-Function-TableNumber-is-not-resetting-local-error-handling
https://hde.dataaccess.eu/
http://support.dataaccess.com/forums/forumdisplay.php?s=3c81b57d0a8fed052d6bc155981336bc&f=31
http://support.dataaccess.com/forums/forumdisplay.php?s=3c81b57d0a8fed052d6bc155981336bc&f=31

